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ELECTRONIC SPREADSHEETS 

1.0 INTRODUCTION 
A spreadsheet is a two-dimensional array of cells which are used to store and 

process data. An individual cell in it is addressed by the corresponding row number 
and column and can be used to store one data item. The utility of spreadsheet 
depends upon the operations allowed on the data by the associated software. The 
computerized spreadsheets allow quick formulation of problems of a wide variety 
without use of any programming language. A number of spreadsheets packages are 
currently available, for example, Lotus, Microsoft Excel, and Quattro Pro. The main 
advantages in using an electronic spreadsheet are: 

Alphanumeric data can be stored in the worksheet, 
Calculations can be performed using formulas and built-in functions. The 
variables are denoted in terms of cell address. 
A formula can be written for one cell and then copied to other cells. 
Using the data stored in the worksheet, graphs can be plotted very easily. 

In the following, the main features of Microsoft Excel will be described. 

2.0 Microsoft Excel 
The Microsoft Excel (MSE) is a package for data manipulation through an 

electronic worksheet. Fig. 1 shows a typical screen of MSE. 
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Fig. 1 A typical screen of Microsoft Excel 

The MSE was developed by Microsoft Corporation, USA. A variety of data 
manipulation capabilities are available in MSE. Besides, comprehensive on-line help 
and tutorials are also available. The entire system is menu driven. The main features 
of this software are described below. For further details, the user is requested to refer 



to the Users Manual for the software. 

In MSE, the normal document is termed as workbook A workbook consists of 

many sheets such as worksheets or chartsheets. The data are stored in worksheets. 
When the MSE is started, a new empty workbook is created. When a new workbook 
is created or opened, it is displayed in a window. One can move or copy sheets 
between workbooks. A worksheet is a grid of rows and columns. Each cell is the 
intersection of a row and a column and has a unique address. In MSE, the rows are 
numbered 1,2,3... and the columns A,B,C... For example, the cell at the intersection 
of column D and row 4 is the cell D4. The size of a sheet is 256 columns and 16384 
rows. Fig. 2 shows a typical workbook of MSE. 
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Fig. 2 A typical workbook of Microsoft Excel 

The MSE can open and save files in many different formats from several 
applications, including Lotus 1-2-3, Quattro Pro for MS-DOS and dBASE. To specify 
the type of file that a user wants to open or save, he chooses Open or Save As from 
the File menu. The appropriate file format is selected from the Open or Save AS 
dialog box_ 

2.1 Entering and Editing Data 
A data value can be entered in a cell by moving to that cell through arrow keys 

or mouse. The data is typed and ENTER key is pressed. A cell can contain constant 
value such as numeric data, date, time, currency, or text. These values do not change 
unless they are edited. A cell can also contain a formula which is a sequence of 
values, cell references, names, functions or operators that produce a new value from 
existing values. Such values produced as the result of a formula can change when 
other values in the worksheet change. 

The number displayed in a cell is based on the cell number format and differs 
from the number MSE stores. The general format displays the numbers as precisely 
as possible, using integer format, decimal faction or scientific notation. However, the 
numbers are stored with 15 digit accuracy and in calculation, the stored number is 
used irrespective of how it is displayed. 
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Several hot keys are available for easy movement in a sheet. The arrow keys 
can be used to move up, down, left and right. Page-up or Page-down move up/down 
by one window. Home key moves to the beginning of the row, Ctrl+Home to the 
beginning of the sheet, and Ctrl+End to the last cell containing data in the sheet. The 
Name box is used to move to a specific location on a worksheet. The Find command 
from the Edit menu can be used to find specific characters on the worksheet. The 
scrolling button on the bottom of the screen are used to switch between different 
sheets in a workbook. 

In many instances, it is necessary to select a group of cells which are always 
rectangular blocks of cells. A range of cells can be selected by dragging the cursor 
diagonally from the first cell to the last cell. To select nonadjacent cells, the Ctrl key 
is held down and the mouse is clicked through additional cells. An entire row is 
selected by clicking the row heading, an entire column by clicking the column heading, 
and all the cells on the sheet are selected by clicking the Select All button. 

A number can be entered in a cell by moving to the desired cell, typing-in the 
number and pressing Enter or Arrow keys. The contents of a cell can be copied into 
other cells by dragging the fill handle or by using the Fill command from the Edit 
menu. For example, select a cell contain a number, say 50. To fill this number to the 
other cells, point to the fill handle at the lower-right corner. The pointer changes to a 
+ sign. Now drag the fill handle in the direction of fill, releasing the button fills the data 
into the range. This procedure is explained in Fig. 3. When the fill handle is dragged 
in a range of cells containing the values that MSE recognizes as a series of sequential 
numbers, the series is incremented in the selected range. For example, if the initial 
selection is 10, 20, the extended series will be 30, 40, 50.... A frequently used special 
series of data can also be created and filled using AutoFill. 

When you release the mouse button, 
the data is tilled into the range. — 

Fig. 3 Filling the data in a sheet 

2.2 Formulas for Data Analysis 
The formulas are used to analyze data on a worksheet. The formulas available 
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in MSE can perform operations such as addition, multiplication, and comparison on 
worksheet values. A formula begins with an equal sign(=) and can be thought of as 
one side of an equation whose result will appear in the cell. A formula can be typed 
in an active cell. For example, a cell, say 81, may contain a formula =A1*5. If the 
content of cell Al is 10, the value in cell B1 will be 50. A noteworthy point is that if the 
content of Al is changed to 50, the content of 131 will automatically change to 250. 
Normally the resulting value of the formula is displayed in the worksheet. When a cell 
containing a formula is selected, the formula is displayed in the formula bar. The 
formula contained in a cell can be copied to a new cell. If MSE can't calculate the 
formula for a cell properly, an error value is displayed. 

The data located in different areas can be referenced in a formula by using 
either absolute, relative or mixed reference. An absolute reference is given by putting 
$ sign before the row and column address (e.g., $A$6) while A6 is a relative reference 
and $A6 is a mixed reference. When a cell containing a copy or moved, the MSE 
automatically adjusts the relative references and the relative parts of mixed references. 
For example, if cell 88 contains the formula =SUM(B2:134) which is copied to C8, the 
formula becomes =SUM(C2:C4). L_ikewise, if the formula =SUM(C$4+$B$1+$135) in 
cell C5 is copied to cell F8, it becomes =SUM(F$4+$13$1+$138). The data stored in 
other sheets can also be referenced in a formula. A function is a special pre-written 
formula that takes value(s), performs an action and returns values. Functions can be 
used alone or as building blocks in larger formulas and simplify and shorten formulas. 
A formula can also be build using a tool known as Function Wizard which can be 
invoked by clicking the Function Wizard button. See Fig. 4 for the steps. 

1- You can view a list of all function names or 
I select a function category to narrow the list. 

Moves to Step 2, using 
the selected function. - 

Skips the next step and inserts the 
function with argument placeholders.- 

Disprayp the name, arguments,. 
and a short description for 
the selected function. 

Fig. 4 Building a formula using Function Wizard 

2.3 Creating a Chart 
A chart is a graphic representation of worksheet data. Values from worksheet 

cells, or data points are displayed as bars, lines, columns, pie slices, or other shapes 
in the chart. Data points are grouped in data series, which are distinguished by 
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different colours or patterns. The ChartWizard is a series of dialog boxes that 
simplifies creating a chart. It guides the process step by step; the user verifies the 
data selection, selects a chart type, and decides whether to add items such as titles 
and a legend. A sample of the chart being created is displayed so that the user can 
make changes before finishing work in the ChartWizard. 

The user can create and embed chart as an object on a worksheet when he 
wants to display a chart along with its associated data. An embedded chart is shown 
in Fig. 5. Alternately, it can be created as a separate sheet in a workbook. In both 
cases, the chart data is automatically linked to the worksheet and when the data on 
the worksheet is changed, the chart is automatically updated. 

Fig. 5 A chart embedded in a worksheet 

2.4 Analysis of Data 
MSE contained a set of tools, named 'Analysis ToolPak' for data analysis. 

These tools include statistical analyses and engineering analyses. Some of the tools 
available in, this 'ToolPak' are Anova, Covariance, correlation, F-test, histogram, 
moving average, random number generation, regression, t-test, and Fourier analysis. 

2.5 Printing 
It is necessary to select and install a printer to print from MSE. Choose the 

'Print command from the 'File' menu. The print dialog box opens and the print range 
and number of copies can be chosen. Alternately Print button is clicked by mouse to 
print immediately from the workbook window. The matter to be printed can also be 
previewed before it is sent for printing. The matter is displayed on the screen exactly 
as it will be printed and this usually saves time and avoids wasteful printing. 

2.6 Entering Text 
To enter text, select a cell and type the text. A cell can hold up to 255 

characters. Characters can format within a cell individually. The user can create text 
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entries that include numbers & text. First, the user applies the text format to the blank 
cells. Choose the cell commend from the format menu, select the number tab, and 
then select the text category and the @ format code. Another way to enter a number 
as text is to precede the entry with an apostrophe. Instead of letting long strings of text 
overflow into adjacent cells, the text can be displayed on multiple lines within a cell. 
This is called text wrapping. Before wrapping text, adjust the column to the desired 
width. Choose the cells command from the format menu, select the Alignment tab and 
then select the Wrap Text check box. To enter text in formulas, enclose the characters 
in double quotation marks. 

2.7 Worksheet Editing 
The user can edit a cell on a worksheet by typing a new entry over an existing 

one or by editing the information within the cell. To edit within a cell, double click the 
cell. To edit a cell containing a formula the formula is displayed and the value is 
hidden. To edit cell contents, choose commands from 'edit' menu. The location of cell 
on a worksheet can be also changed by copying or moving cell to a different part of 
the same worksheet, to another worksheet within a workbook or to another application. 
Fig. 6 explains the steps of copying and moving cells. Spelling command of the' Tools' 
menu is used to correct the spelling of worksheets and charts. If the user frequently 
uses some specialized terms he can create a custom dictionary. To create a custom 
dictionary, choose the spelling command from the 'tools' menu, type a name for the 
new dictionary in the Add words to box, and then choose the 'Add' button. 

2.8 Creating Graphic Object on Worksheets 
The graphic objects are not actually part of the worksheet or chart. They are 

inserted on a transparent layer laid over the worksheet and can be moved, sized and 
formatted independently of the dates or chart underneath. The graphic object can be 
draw by using buttons on the 'Drawing toolbar'. Click the 'Drawing button' by mouse 
to display the 'Drawing toolbar'. To draw a simple shape, click one of the buttons on 
the Drawing toolbar and drag from one corner of the area where the shape to appear 
to the diagonally opposite corner. Double click the button to draw more then one 
shape in succession. To stop drawing shapes, click the button again. To delete a 
graphic object click to select it and then press the DEL Key. To change the format size 
or position of an object or to copy or delete an object, it is necessary select it first. 

2.9 Help and Demos 
The various commands and features of the MSE have been documented in the 

Microsoft Excel User's Guide. Besides, an extensive on-line documentation is also 
available. This contains detailed step-by-step instructions and reference information 
for all tasks and features including commands, toolbar buttons, functions, and the 
Visual Basic language. The on-line help can be accessed using the Help Menu. A 
number of examples and demos contain short interactive lessons that focus on a 
single task. These have been also designed to work as tutorials sessions. Also 
included with the MSE package are some sample files which can also be included in 
the workbooks of a user. 

2.10 Working with Chart Types and Autoformatting 
To create a chart from worksheet data, it is necessary to choose the chart type 
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that presents that particular data most clearly and effectively. MSE offers 14 different 
chart types. The user can choose a chart type for the entire chart or can assign a 
chart type to one or more data series. Each chart type has at least one subtype, which 
can choose to show the data somewhat differently. User can use subtypes and chart 
type in combinations to create a variety of looks. Once the user creates a chart he can 
move, size and change the look of many chart items by apply an autoformat to the 
chart instead of selecting and formatting individual items. Autoformat changes the 
entire look of the chart but does not affect the data. To change the chart type first 
activate the 'chart'. Then choose the 'chart type' command from the 'Format' menu and 
select the chart type. The user can quickly combine chart types by choosing a 
combination autoformat instead of changing the chart type for individual series. 
'Autoformat' command saves time and give the charts a consistent hook. The user can 
use built-in 'autoformats' or can create own custom autoformats. 

2.11 Organizing and Managing Data in a List 
One way to store data on a worksheet is in a list. A list is a labelled series of 

rows that contains similar data. MSE has a number of automatic features that make 
it easy to manage and analyze data in a list. To take full advantage of these features 
enters rows and columns in a list according to the following guide lines. 

Avoid having more than one list on a worksheet, because some list 
management features such on filtering are used on only one list at a time on 
a worksheet. 
Leave at least one blank column and one blank row between the list and other 
data on the worksheet. 
For best results avoid storing other critical data to the left or right of the list 
because it can be hidden when user filters the list. 
A list can be as large as an entire worksheet; 16,384 rows by 256 columns. 
Create column labels in the first row of the list. MSE uses these labels to create 
reports and final and organize data. 
Use a font, data type alignment, format pattern, border or capitalization style for 
column labels that is different from the format assign to the data in the list. 
Use Cell borders to insert lines below the labels to separate the labels from the 
data. Do not use blank rows or dashed lines. 
Column labels, like other cells can contain a max of 255 characters. 
Design list so that all the rows hence similar items in the same column. 
Do not insert extra spaces at the beginning of a cell; extra spaces affect sorting 
& searching. 
Use the same format on all the cells in a column. 

If the worksheet data is stored as a list, MSE makes it easy to organize the list, 
edit it and create reports from it. 

2.12 Sorting & Filtering Data in a List 
MSE makes it easy to organize, find and create reports from data stored in a 

list. Sorting is an easy way to organize data in a list alphabetically, numerically or 
chronologically. Similarly filtering is a quick and easy way to find and work with a 
subset of data in a list. When filtering a list, MSE displays only those rows that contain 
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a certain value, or that meet a set of search conditions called criteria. To sort entire 
list just select a single cell in the list and choose the sort command from the Data 
menu. MSE automatically selects the whole list. If the list has column labels in the first 
new, MSE excludes them from the sort and uses them to help choose the sort by 
column. Autofilter is used to display a subset of the list. 

2.13 Using Solver to Analyze Multiple Variable Problems 
MSE 'solver' is a powerful optimization and resource allocation tool. It can help 

to determine the best uses of scarce resources so that desired goals such as profit 
can be maximized, or undesired goals such as cost can be minimized. Use solver to 
find the optimum value for a particular cell by adjusting the values of several cells. To 
use MSE solver with worksheet model, define a problem that needs to be solved by 
identifying a target cell, the changing cells, and the constraints that is used in the 
analysis. After define the problem, start the solution process. Solver finds values that 
satisfy the constraints and produces the desired value for the target call. Solver then 
displays the resulting values on worksheet. 

2.14 Statistical Analysis of Data 
MSE provides a set of special analysis tools called the analysis 'ToolPak'. 

These tools save steps in developing complex analysis scenarios. Before using an 
analysis tool, the data must be entered and organized into columns or rows in 
worksheet. When the user uses an analysis tool to analyze data in an input range, 
MSE creates an output table of the results. The contents of the output table depend 
on the analysis tools which are being used. If labels are included in the input range, 
MSE uses them to label data in output table. If labels are not included in the input 
range, MSE automatically generates data labels for the result in the output table. The 
user can save the output table on the same sheet on the input range, on a separate 
sheet in the same workbook, or in a new workbook. If he attempts to save output table 
in a location where data already exists, MSE gives the opportunity to specify a new 
location. To use an 'Analysis tool', choose 'data analysis' from the 'tool' menu. In the 
'Analysis tool box', select the name of the tool which is desired then specify the input 
and output ranges and any other options. 

2.15 Protecting Workbooks, Sheets and Their Contents 
Once user creates a workbook, he can restrict the way others can access the 

workbook or its contents. MSE gives several options for restricting access and 
changes at the workbook label, at the sheet level and even at the cell or graphic 
object level. The user can: 

Prevent other users from opening a workbook or accessing its contents. 
Enable other users to open a workbook and enter changes to its contents but 
prevent them from replacing the original copy. 
Enable user to open a workbook, but not change its contents or the way it's 
organized and displayed. 
Prevent other user from entering changes to some or all of the items on a 
sheet. 
Hide a workbook so other users can open or access it but not see it. 
Hide selected sheets in an open workbook. 
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Hide some or all items on a sheet so other user can not see them or 
accidentally change them. 
Prevent worksheet formulas from appearing in the formula bar. 

Using passwords user can mix different levels of protection for the same 
workbook so that different groups of people have different levels or access. 

2.16 Linking and Embedding 
With the 'linking and embedding' features available in MSE, the user can 

include information, or objects, created in other application. Embedding means 
inserting information, such as a chart, a graphic, or data from a word processor 
document into a MSE workbook. Embedded objects become part of the workbook 
itself. Linking means inserting into a workbook information that retains a connection 
to the source document. Linked data is update when the data in the source document 
changes. Linked data is stored in the source file, the workbook stores only the location 
of the source but displays a representation of the linked data. 

2.17 Importing and Exporting Documents 
With the 'open' command on the `file' menu, the user can open documents 

created by many other applications, including Lotus 1-2-3, Borland Quattropro, and 
dBASE. He can also save documents using the 'save as' command on the file menu 
in file formats readable by many other applications. The list of supported file formats 
appears in the open dialog box under list files of type, and in the 'save as' dialog box 
under 'save file as' type. 

If the file type can not save multiple sheets, a message appears to inform that 
only the active sheet will be saved. User can also open and save text files. When he 
open a text file, the TextWizard opens so he can specify how he want the text 
distributed across columns. 

2.18 Producing a Slide Show 
User can create a 'slide show' with MSE to present data, charts and graphics 

created in MSE or imported from other application. 'Slide shows' are created on a 
special template included with MSE. He can include a variety of graphics in a 'slide 
show' and apply a number of video and audio transition effects between slides. 'Slide 
shows' can be saved in a workbook and can be viewed on other computers 'slide 
shows' can be run only on a computer screen or on another display device attached 
to computer they can not printed. 

To create and display 'slide shows', the 'slide show add in' must be installed. 
Help command gives complete information about slide shows and how they work. 

3.0 Hardware & Software Requirements 
The following are required to use Microsoft Excel for Windows : 
Any IBM-compatible machine with 80286 processor or higher, 
A 3.5 inch or 5.25 inch floppy disk drive, 
A hard disk with sufficient free space, 
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A graphic display compatible with Microsoft Windows Ver 3.1 or later, such as 
EGA or VGA, 
At least 4 MB of CPU memory, 
MS-DOS Ver 3.1 or later, and Microsoft Windows Ver 3.1 or later in standard 
or enhanced mode, 
A compatible printer, if hardcopy output is needed, 
A compatible mouse (recommended). 
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Choose the Paste 
command from the Edit 
menu or shortcut menu. 
The destination cell becomes 
the upper-left corner of 
the paste area. 

The moving border 
indicates that you 
can paste the copied 
cells again. To cancel 
the border, press ESC. 

Choose the Paste 
command from the Edit menu 
or shortcut menu. The 
destination cell becomes 
the upper-lett corner 
ol the paste area. 

— The cut area is cleared. 
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